
This product records videos while the vehicle is operating.

Read and follow the instructions in this guide to properly use and maintain the product.

User Guide

U3000



Before using the product

About the product

This product records videos while the vehicle is operating. Use this product only for reference when 

investigating incidents or road accidents. This product is not guaranteed to record for all events. The 

device may not record accidents with impacts that are too minor to activate the impact sensor or accidents 

with massive impacts that cause the vehicle’s battery voltage to deviate.

Video recording does not begin until the product is completely turned on (booted up). To ensure that all 

vehicle events are recorded, wait until the product is completely booted up after turning it on, and then 

begin operating the vehicle.

THINKWARE is not responsible for any loss caused by an accident, nor is it responsible for providing any 

support regarding the outcome of an accident.

Depending on the vehicle’s configuration or operating conditions, such as the installation of remote door 

lock devices, ECU settings, or TPMS settings, some product features may not be supported, and different 

firmware versions may influence the product’s performance or features.

About the user guide

The information provided in the guide may change when the manufacturer updates its service policy.

This user guide is intended for THINKWARE U3000 model only, and it may contain technical errors, editorial 

errors, or missing information.

Copyrights

All rights for the content and maps in this guide are reserved by THINKWARE and are protected under 

copyright laws. All unauthorized duplication, revision, publication, or distribution of this guide without 

written consent from THINKWARE is prohibited and is eligible for criminal charges.

Registered trademarks

THINKWARE U3000 is a registered trademark of THINKWARE.

Other product logos and service names in this guide are trademarks of the relevant companies.
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Safety information
Read the following safety information to properly use the product.

Safety symbols in this guide

"Warning" - Indicates a potential hazard which, if not avoided, may result in injury or death.

"Caution" - Indicates a potential hazard which, if not avoided, may result in minor injury or property damage.

"Note" - Provides useful information to help users better utilize the product’s features.

Safety information for proper use

Driving and product operation

• Do not operate the product while driving a vehicle. Distraction while driving may cause accidents and 

result in injury or death.

• Install the product in places where the driver’s view is not obstructed. Obstruction of the driver’s vision 

may cause accidents and result in injury or death. Check with your state and municipal laws before 

mounting the product to the windshield.

Power supply

• Do not operate or handle the power cable with wet hands. Doing so may result in electrocution.

• Do not use damaged power cables. Doing so may result in electrical fire or electrocution.

• Keep the power cable away from all heat sources. Failure to do so may cause the power cord insulation to 

melt, resulting in electrical fire or electrocution.

• Use the power cable with the correct connector and make sure the power cable is connected securely 

and is firmly in place. Failure to do so may result in electrical fire or electrocution.

• Do not modify or cut the power cable. Also, do not place heavy objects on the power cable or pull, insert, 

or bend the power cable using excessive force. Doing so may result in electrical fire or electrocution.

• Use only genuine accessories from THINKWARE or an authorized THINKWARE dealer. THINKWARE does 

not guarantee compatibility and normal operation of third-party accessories.

• When connecting the power cable to the product, ensure that the connection between the cable plug 

and the power cable connector on the product is secure. If the connection is loose, the power cable may 

become disconnected due to vehicle vibration. Video recording is not available if the power connector is 

disconnected.
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Children and pets

Ensure that the product is out of the reach of children and pets. If the product breaks, it may result in fatal 

damage.

Other information about the product

Product management and operation

• Do not separate the product and the mount when the product is turned on. Doing so may result in product 

malfunction.

• Do not expose the product to direct sunlight or intense light. The lens or internal circuitry may fail otherwise.

• Use the product at a temperature between 14°F and 140°F (-10°C to 60°C) and store the product at a 

temperature between -4°F and 158°F (-20°C to 70°C). The product may not function as designed and some 

permanent physical damages may result if it is operated or stored out of the specified temperature ranges. 

Such damages are not covered by the warranty.

• Frequently check the product for the proper installation position. Impact caused by extreme road conditions 

may alter the installation position. Ensure that the product is positioned as instructed in this guide.

• Do not apply excessive force when pressing the buttons. Doing so may damage the buttons.

• Do not use chemical cleaners or solvents to clean the product. Doing so may damage plastic components of 

the product. Clean the product using a clean, soft, and dry fabric.

• Do not disassemble the product or subject the product to impact. Doing so may damage the product. 

Unauthorized disassembly of the product voids the product warranty.

• Handle with care. If you drop, mishandle, or expose the product to external shocks, it may cause damage 

and/or result in the malfunction of the product.

• Do not attempt to insert foreign objects into the device. Doing so may damage the product.

• Avoid excessive humidity and do not allow any water to enter the product. Electronic components inside the 

product may fail if exposed to humidity or water.

• Depending on the make and model of your car, the power may be constantly supplied to the dash cam 

even when the ignition is turned off. Installation of the device to a continuously powered 12V outlet could 

result in vehicle battery drainage.

• This device is designed to record video while the vehicle is in operation. The quality of the video might be 

affected by weather conditions and the road environment, such as whether it is day or night, presence of 

street lighting, entering/exiting tunnels, and the surrounding temperature.

• THINKWARE is NOT responsible for the loss of any recorded video during operation.

• Although the device was designed to withstand high-impact car collisions, THINKWARE does not 

guarantee the recording of accidents when the device is damaged as a result of the accident.

• Keep the windshield and camera lens clean for optimal video quality. Particles and substances on the 

camera lens or windshield may reduce the quality of the recorded videos.

• This device is intended to be used inside the vehicle only.
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1. Product overview

1.1 Included items

Ensure that all the items are included when you open the product box.

1.1.1 Standard items

Front camera (main unit) Mount Car charger

Trim Tool 

A
C
C

B
A
T
T
E
R
Y

G
N
D

Hardwiring cable

Heat Blocking Film Adhesive cable holder

MicroSD memory card with adapter 

(consumable)

Warranty & CS information CPL filter

The standard items may change without prior notice.

1.1.2 Accessories (sold separately)

Rear camera and cable OBD-ll Cable
(included in 2CH bundle)
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1.2 Part names

1.2.1 Front camera (main unit) - front view

Front camera lens  

Records the front view.

Security LED  

Indicates that video is 

being recorded.

Adhesive mount  

Used to fix the front camera 

in the vehicle.

� To reset the product, press and hold the voice recording ( ) and manual recording ( REC) buttons 

simultaneously until you hear beeps.

� Refer to the following table to check the status of the product using the LED indicators.

For more information about the REC LED, refer to "3.3 Using the continuous recording feature" on page 18.

LED LED status Operation description

BT/WiFi

 (flickers) Waiting for Wi-Fi connection

 (light on) Wi-Fi connected

 (flickers) Waiting for Bluetooth connection

 (flickers quickly) Bluetooth pairing

 (light on) Bluetooth connected

 (flickers) Internet Mode (not connected)

 (light on) Internet Mode connected

 >   >   (light on) Bluetooth/Wi-Fi reset

OFF OFF

GPS
 (light on) GPS connected

OFF Not connected

Misc.
Connection  > REC  >  GPS  (light on) Firmware upgrade

Connection/REC  (flickers 5 times) System error
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1.2.2 Front camera (main unit) - rear view

GPS LED 
Indicates the GPS 
connection status.

REC LED 
Indicates the recording status.

Memory card slot
Insert a memory card to 
save recordings.

Reset button 
Insert the tip of a sharp object 
to reset the product when an 
error occurs.

Voice recording button
Press to enable or 
disable voice recording.

Connection button
Press to connect the product  
to a smartphone via Bluetooth 
or Wi-Fi network.

Power button

• Press and hold to turn off the product.

• Press to turn on the product.

Speaker 
Outputs the voice guide and 

buzzer sounds to indicate 
the product’s status.

Manual recording button

• Press to start manual recording.

• Press and hold for  
3 seconds for SOS recording.

Connection LED 
Indicates the Wi-Fi and 

Bluetooth connection status.

V-IN input port 
Used to connect the rear camera (optional).

DC-IN power port
Used to connect the power cable.

1.2.3 Rear camera (optional)

Connection port 
Used to connect the rear 
camera to the front camera 
using a rear camera cable.

Rear camera lens 
Records the rear view.

Security LED 
Indicates that video is being recorded.

Adhesive mount 
Used to fix the rear camera 
in the vehicle.

Depending on the laws and regulations of the country, the security LED specifications may be different.
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1.3 Removing and inserting the memory card

Follow the instructions to remove the memory card from the product or to insert the memory card into the 

product.

Before removing the memory card, ensure that the product 

is turned off. Gently push the bottom of the memory card 

with your fingernail to release it, and then remove it from the 

product.

To insert the memory card into the memory card slot, ensure 

that the metal contacts on the memory card are facing toward 

the product’s buttons, and insert it into the slot until you hear 

a click.

• Ensure that the product is turned off before removing the memory card. The recorded video files may be 
corrupted or lost if you remove the memory card while the product is on.

• Ensure that the memory card is in the correct direction before inserting it into the product. The memory 
card slot or the memory card may be damaged if it is inserted incorrectly.

• Use only authentic memory cards from THINKWARE. THINKWARE does not guarantee the compatibility and 
normal operation of third-party memory cards.

To prevent loss of recorded video files, periodically back up the video files on a separate storage device.
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2. Installing the product

2.1 Installing the front camera (main unit)

Follow the instructions to properly install the product.

2.1.1 Selecting an installation location

Select an installation location that can record the 

entire view in front of the vehicle without obstructing 

the driver’s vision. Ensure that the front camera lens 

is located in the center of the windshield.

20 cm

If a GPS navigating device is installed on the dashboard, 

its GPS reception may be affected depending on the 

dashboard camera’s installation location.

Adjust the installation location of the GPS navigating 

device to ensure that the two devices are separated by 

at least 20 centimeters (approximately 8 inches).

2.1.2 Securing the product

Follow the instructions to secure the product at the installation location.

1 After determining the installation location, wipe the installation location on the windshield with a dry 

cloth.

2 Attach the heat blocking film to the installation 

location.

Attach the heat blocking film where the front 

camera will not be blocked. 
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3 

2
1➊➊ ➋➋

Remove the protective film from the adhesive mount, 

and then press the mount to the heat blocking film. 

Push the mount against the windshield to ensure 

that the mount is firmly fixed. 

4 Align the product to the mount, and then slide it into 

the locking position until you hear a click. 

• The product may fall and be damaged during 

vehicle operation if it is not firmly fixed to the 

mount.

• If you need to remove the mount from the 

windshield to alter the installation location, be 

careful not to damage the windshield’s film coat.

5 Set the vertical angle of the camera appropriately.

To confirm the camera angle, record a video after installation and check the video using the mobile 

viewer or the PC viewer. If necessary, adjust the camera angle again. For more information about the 

mobile viewer or the PC viewer, refer to "4. Using the mobile viewer" on page 23 or "6. Using the PC 

viewer" on page 25.
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2.1.3 Connecting the power cable

When the engine and electrical accessories are turned off, connect the continuous power cable or the 

cigar socket power cable to the product.

Connecting the car charger

2

➊

➋

Connect the car charger to the product’s DC-IN power
port and insert the cigar jack into the vehicle’s power
socket.

The location and specifications of the power socket
may differ by vehicle make and model.

Connecting the OBD-II Power Cable

To connect, plug the OBD-II Cable into the OBD-II Port in your 
vehicle and connect the Power Port with the Dash Cam. 

The OBD-II cable enables parking mode so that the camera 
continues operating even when the vehicle is not. In parking 
mode, the camera detects impacts to the vehicle and nearby 
motion and records video.

The locations and specifications of the OBD-II port 
may differ by vehicle make and model.

➋

1/8 1/4

Connect the product to THINKWARE DASH CAM LINK on
your smartphone and adjust the camera angle so that the
hood of the vehicle covers 1/4 - 1/8 of the screen while
viewing the live view screen, as shown in the image to
the left.
For more information about connecting and using the
THINKWARE DASH CAM LINK, refer to "4. Using the
mobile viewer" on page 23.

 � Use the authentic THINKWARE car charger. Use of third party power cables may damage the product and
result in electrical fire or electrocution due to the voltage difference.

� Do not cut or modify the power cable yourself. Doing so may damage the product or the vehicle.

� For safe driving, arrange the cables to prevent the driver's vision from being obstructed or interfering with
driving. For more information about arranging cables, visit www.thinkware.com.

  

 � It may take a couple of minutes to switch to Parking mode after the ignition is switched off.
� Use the authentic THINKWARE OBD-II power cable only. Using other manufacturer’s cable may damage the
product or cause electrocution due to the voltage difference.

  

➊

http://www.thinkware.com
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Connecting the continuous hardwiring cable

A
C
C

B
A
T
T
E
R
YGND

If you connect the product to the vehicle via the 

continuous power cable, the camera continues operating 

even when the vehicle is not operating (parking mode). In 

parking mode, the camera detects impacts to the vehicle 

and nearby motion and records video.

For	more	information	about	parking	mode,	refer	to	"3.6	
Using parking mode" on page 20.

• The continuous power cable must be professionally installed in the vehicle by a trained mechanic. Contact 

an authorized service center to connect the continuous power cable to the vehicle. If the product is not 

installed properly, the product may be damaged or an electrical fire or electrocution may occur.

• Use the authentic THINKWARE continuous power cable only. Using other manufacturer’s cable may 

damage the product or cause electrocution due to the voltage difference.

• When connecting the continuous power cable, pay special attention to wiring. If the wires are connected 

incorrectly, the product or the vehicle may be damaged.

1 Find the vehicle’s fuse box. Usually the fuse box is 

installed under the driver’s seat.

The location of the fuse box may differ 

depending on the make and model of the 

vehicle. For more information, refer to your 

vehicle’s owner’s manual.

2 Open the fuse box, find the continuous power 

terminal (which supplies power when the vehicle 

is off) and the ACC terminal (which supplies power 

when the ignition status is "ACC ON") by using an 

electrical tester, and detach the fuses from the 

terminals.

3 

BATTERY

ACC

Connect the BATTERY wire to a fuse leg of the 

continuous power terminal and connect the ACC 

wire to a fuse leg of the normal (ACC) terminal.
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4 Check the fuse panel’s input and output contact points by using an electrical tester.

5 Place the fuses back into their locations on the fuse panel, connecting each fuse leg with the wire to 

the output contact point and taking care not to change the fuse position.

When you install the fuses on the fuse panel, the fuse legs for the BATTERY wire and the ACC wire 

must be connected to the output terminals respectively. If the fuse leg with the wire is connected to an 

input terminal, the product or vehicle may be damaged or electrical fire may result.

6 

G
N
D

Connect the ground wire (the GND wire) to a bolt 

attached to a metallic part of the vehicle’s body.

Normally, the metallic bolt that you can 

connect the ground wire to (the GND wire) is 

fitted nearby fuse box or the driver seat’s door 

interior.

7 Connect the continuous power cable to the product’s DC-IN power connector and start the engine to 

make sure the product operates normally.

Once the product is powered on, the LED indicator and the voice guidance are turned on.

8 Install the THINKWARE DASH CAM LINK on your smartphone via the Google Play Store or the Apple 

App Store.

For more information about connecting and using the THINKWARE DASH CAM LINK, refer to "4. Using 

the mobile viewer" on page 23.

9 Adjust the camera angle so that the hood of the vehicle covers 1/4 - 1/8 of the screen while viewing 

the live view on the LCD screen.

For more information about adjusting angle, refer to "Connecting the car charger" on page 12.
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2.2 Installing the rear camera (optional)

Refer to the following instructions to properly install the rear camera.

2.2.1 Selecting an installation location

Select a location on the rear windshield where there 

is no defrost grid wire and the camera can record 

the entire rear view.

• For vehicles with a sunshade attached to the rear windshield, you must select a location where using the 

sunshade will not interfere with camera operation.

• The adhesive part of the rear camera should not touch the defrost grid. 

2.2.2 Securing the rear camera

Refer to the following instructions to secure the product to the installation location.

1 After determining the installation location, wipe the installation surface of the windshield with a dry 

cloth.

Check the installation location before you secure the rear camera to the rear windshield. After 

securing the rear camera to the windshield, it is hard to remove the camera or change the installation 

location due to the strong adhesive. 

2 

2
1➊➊➋➋

Remove the protective film from the adhesive mount 

and camera lens.
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3 Attach the product with the THINKWARE logo facing 

indoors and press the adhesive tape firmly to 

secure the camera.

If the product is fixed in reverse, the rear view 

will be recorded upside down.

4 Adjust the camera’s vertical angle.

2.2.3 Connecting the rear camera cable

Power off the product and connect the rear camera cable to the front camera (main unit).

When connecting the rear camera cable, check the "F" and "R" marks on both ends of the cable.

1 Connect one end of the rear camera cable  

(marked F ) to the front camera’s V-IN port

To prevent malfunction, make sure to connect the 

appropriate cable with the label marked FRONT to   

the front camera’s V-IN port.
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2 Connect the other end of the rear camera cable 

(marked R) to the rear camera’s connection port. 

For safe driving, arrange the cables to prevent 

the driver’s vision from being obstructed or 

interfering with driving. 

3 Turn on the ACC or start the engine to check if the product is powered on. After the product is powered 

on, the voice guidance will be turned on.

The product is powered on when the ACC mode is turned on or when the engine starts.

4 When attaching the rear camera, check the live 

view with the mobile viewer application. Launch 

THINKWARE DASH CAM LINK on your smartphone 

and tap Live View > R to switch the screen to the 

rear view. Align the red line with the center of 

the camera, the yellow line with the center of the 

horizon, and the green line with the trunk line.

To adjust the angle more precisely after attaching 

the rear camera, launch THINKWARE DASH CAM 

LINK on your smartphone, tap Live View > R >  

and then further adjust the horizontal (yellow) and 

trunk (green) lines on the application screen.

If the rear camera is not installed correctly, the Rear Collision Warning (RCWS) feature may not work 

properly.
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3. Using recording features

3.1 Turning the product on or off

The product is turned on automatically and continuous recording starts when you turn on the ACC or start 

the engine.

Wait until the product is completely booted up after turning it on, and then begin operating the vehicle. The 
video recording does not begin until the product is completely turned on (booted up).

3.2 Learning about the file storage locations

Videos are stored in the following folders according to their recording mode.

On the mobile 
viewer

Continuous
Continuous 

Incident
Manual 

Recording
Motion Detection

Parking 
Incident

SOS 
Recording

In the memory 
card 

cont_rec evt_rec manual_rec
motion_ 

timelapse_rec
parking_rec sos_rec

Play videos on Window/Mac computers or using the THINKWARE DASH CAM LINK. If you play videos by 
inserting the memory card in devices such as a smartphone or a tablet PC, the video files may be lost.

A file name is composed of the recording start date and time, and the recording option.

REC_20220901_102530_F.MP4

REC_20220901_102530_R.MP4

YYYYMMDD_HHMMSS
Recording conditions

• F: Front camera

• R:  Rear camera (when optional rear camera is equipped)

3.3 Using the continuous recording feature

Connect the power cable to the product’s DC-IN power port and then turn on the vehicle’s electrical 

accessories or start the engine. The voice guide will indicate that continuous recording has started.

During continuous recording, the product operates as follows.

Mode Operation description REC LED

Continuous 

recording 

During driving, videos are recorded in 1 minute segments and stored in the 

"cont_rec" folder.
  

(light on)

Incident 

continuous 

recording*

When an impact to the vehicle is detected, a video is recorded for  

20 seconds (from 10 seconds before the detection to 10 seconds after the 

detection) and stored in the "evt_rec" folder. 

  

(flickers)

*  When an impact to the vehicle is detected during continuous recording, incident continuous recording starts with a 
double beep sound.
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• Wait until the product is completely booted up after turning it on, and then begin operating the vehicle. The 

video recording does not begin until the product is completely turned on (booted up).

• When incident continuous recording starts, a double "beep" sounds as a notification.

• To enable recording, you must insert a memory card into the product.

3.4 Recording manually

You can record a scene you want to capture while driving and store it as a separate file.

To start manual recording, press the manual REC button. Then, the voice guide will indicate that manual 

recording has started. 

During manual recording, the product operates as follows.

Mode Operation description REC LED

Manual 

recording

When you press the manual recording (REC) button, a video will be recorded 

for 1 minute (from 10 seconds before to 50 seconds after pressing the button) 

and stored in the "manual_rec" folder. 

  

(flickers)

3.5 Using the SOS recording feature

You can record a scene when an accident occurs while driving and store it as a separate file.

To start SOS recording, press the REC button for 3 seconds. During SOS recording, the product operates as 

follows. 

Mode Operation description
Connection LED/ 

REC LED

SOS recording 

If you press the REC button for 3 seconds when an accident occurs, a video 

will be recorded for 10 seconds (from 5 seconds before the accident to 

5 seconds after pressing the button) and stored in the "sos_rec" folder. 

 

(flickers)

• To use this feature, you must sign in to the THINKWARE CONNECTED application.

• The video will be uploaded to the THINKWARE CONNECTED application with the location where the 

accident occurred. 
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3.6  Using parking mode

When the product is connected to the vehicle via the hardwiring cable or OBD-II cable, the operating mode is switched 
to parking mode after the engine or electrical accessories are turne d off and the voice guide will indicate that
the parking mode has started.

� Parking mode operates when the hardwiring cable or OBD-II cable is connected. 
The hardwiring cable must be professionally installed to the vehicle by a trained mechanic. 

� To use all recording modes, you must insert a memory card into the product.

� Depending on the battery charging status of the vehicle, the duration of parking mode may differ. If you 

want to use parking mode for an extended period, check the battery level to prevent battery depletion.

If you do not want to use parking mode or you want to change the mode settings, from the mobile viewer, 

tap Dash Cam Settings > Record Settings.

Refer to the following table to set the Parking Mode options.

Option Operation description REC LED

Motion 

Detection

No motion 

or impact 

detected

Monitors movement in the area or impacts to the vehicle. Video will 

be recorded only when motion or an impact is detected.

Motion 

detected

When a moving object is detected while parking, a video is recorded
for 20 seconds (from 10 seconds before detection to 10 seconds after
detection) and stored in the "motion_timelapse_rec" folder.

  

(flickers)

Impact 

detected

When an impact is detected while parking, a video is recorded for 20
seconds (from 10 seconds before detection to 10 seconds after
detection)  and stored in the "parking_rec" folder.

   

(flickers)

Time 

Lapse

No impact 

detected

A video is recorded at a rate of 2 fps for 10 minutes, compressed into 

a 2-minute long file, and stored in the "motion_timelapse_rec"  folder. 

Since the video file recorded with this option is small, you can record 

a long video.

  

(light on)

  

(flickers slow)

Impact 

detected

When an impact is detected while parking, a video is recorded for 

100 seconds at a rate of 2 fps (from the moment 50 seconds before 

detection to 50 seconds after detection) and stored in the "parking_

rec"  folder after being compressed into a 20-second long file. (The 

buzzer will sound.)

  

(flickers)

Energy 

Saving

No impact 

detected

Monitors impacts to the vehicle. Video will be recorded only when an 

impact is detected.
OFF

Impact 

detected

When an impact is detected while parking, a video is recorded for 

20 seconds (starts recording within 1 sec of detection and records 20 sec 

after detection) and stored in the "parking_rec" folder.

  

(flickers)
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Option Operation description REC LED

RADAR

No motion
or impact
detected

Monitors movement in the area or impacts to the vehicle while 
parking in RADAR mode. Video will be recorded only when motion or 
an impact is detected.  

  

Motion

detected

When a moving object is detected while parking in RADAR mode, a video
is recorded for 20 seconds(from 10 seconds before detection to 
10 seconds after detection) and stored in the "motion_timelapse_rec" folder.   

  

(flickers)

Impact

detected

When an impact is detected while parking in RADAR mode, a video is
recorded for 20 seconds(from 10 seconds before detection to 10 seconds 
after detection)  and stored in the "parking_rec" folder.
(The buzzer will sound.)  

  

(flickers)

OFF
The product is powered off when electric accessories and the engine
are turned off. 

OFF

OFF

If parking mode settings are changed, the videos recorded with the previous settings will be deleted. To prevent 
data loss, back up all parking mode videos before changing parking mode settings.

The built-in radar’s sensitivity level can be adjusted to detect motion starting from 5m of the vehicle at the highest 
sensitivity level or starting from 1m of the vehicle at the lowest level 

You cannot use Motion Detection, Time Lapse, or Energy Saving at the same time. 

3.7 Using the Super night vision feature

With the Super Night Vision feature, you can record videos that are much brighter than videos recorded 

without this feature. This feature is enabled by real-time image signal processing (ISP) to improve the 

brightness of videos recorded.

<When Super Night Vision is deactivated> <When Super Night Vision is activated>

1 From the mobile viewer, tap Dash Cam Settings >  Camera Settings.

2 From Super Night Vision , select the desired recording mode to use the Super Night Vision feature. The 

new setting is applied automatically.
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3.8 Using the road safety features

The road safety features include a safety camera alert system, a lane departure warning system (LDWS), 

a lane departure warning system speed (LDWS Speed), a forward-collision warning system (FCWS), a low 

speed Forward collision warning system (low-speed FCWS), a front vehicle departure warning (FVDW), and 

a Rear Cllision warning system(RCWS).

Safety feature Description 

LDWS  

(Lane Departure Warning)
Detects the lane departure via the real-time video and warns the driver.

LDWS Speed
Detects lane departure and warns the driver when the speed of the vehicle goes 

over the speed selected in the settings.

FCWS

(Forward Collision Warning)

Detects forward collision threats via the real-time video and warns the driver when 

the vehicle is moving at 40 km/h or above.

Low Speed FCWS
Detects forward collision threats via real-time video and warns the driver when the 

vehicle is moving at 10-30 km/h.

FVDW  

(Front Vehicle Departure 

Warning)

Detects the departure of another vehicle that was previously stationary in front of the 

vehicle and notifies the driver after four seconds.

RCWS

(Rear Collision Warning)

Detects rear collision threats via the real-time video and warns the driver when the 
vehicle is moving at 50 km/h or above and saves a recording in events folder.

Road safety features are performed differently depending on the set speed and sensitivity of the features. 
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4. Using the mobile viewer

You can view and manage recorded videos and configure various product features on your smartphone.

One of the following environments is required to use the THINKWARE DASH CAM LINK application:

• Android 7.0 (Nougat) or higher

• iOS 13 or higher

4.1 Connect the product to a smartphone

1 On your smartphone, open the Google Play Store or Apple App Store and download and install 

THINKWARE DASH CAM LINK.

2 Run THINKWARE DASH CAM LINK.

3 Tap Dash cam connection is required. at the bottom of the screen and follow the on-screen instructions 

to connect the product to a smartphone.

4.2 Viewing the mobile viewer screen layout

The following provides brief information about the mobile viewer’s screen layout.
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5. Using THINKWARE CONNECTED 

When using parking mode, you can check vehicle status notifications, such as Live View, parking impact 

notifications, the vehicle voltage status, the dash cam power status, vehicle battery status, and the recent 

parking location on the THINKWARE CONNECTED application depending on your service plan. 

�  One of the following environments is required to use the THINKWARE CONNECTED application:

- Android 7.0 (Nougat) or higher

- iOS 11.4 or higher

�  The services and features provided by THINKWARE CONNECTED application may be changed according to   

the service policy. Refer to the THINKWARE website (https://www.thinkware.com) for more information.

�  Status of the vehicle while driving/parking

� Vehicle battery voltage status

� Dash cam power off

�  Driving history

�  SOS notification, recorded video backup, and SMS transmission

� Driving impact notification, video backup, and SMS transmission

� Parking impact notification and recorded video backup

� Download and share the event location and recorded video

� The captured image of the front camera during the most recent parking

� Real-time vehicle location

� Remote live view

U3000

.

� To use THINKWARE CONNECTED app, the dash cam needs to be connected to the Internet in THINKWARE 

DASH CAM LINK app

� THINKWARE CONNECTED features are not available in the following Parking recording modes:

- Energy Saving

- Radar

� Connecting the dash cam to a mobile hotspot device or a Wi-Fi network with Internet access will consume 

data. Carrier/Service Provider charges may apply.

� The smartphone used to set up the Internet connection on the dash cam cannot also be used as a mobile 

hotspot for the dash cam. A different hotspot device/smartphone is required.

� To connect the dash cam to the internet, use the THINKWARE DASH CAM LINK App. Once the dash cam is 

connected to the internet, you can go to the THINKWARE CONNECTED app to get access to CONNECTED 

features.



5.1  Connecting the product to THINKWARE CONNECTED 

1 On your smartphone, open the Google Play Store or Apple App Store and download and install 

THINKWARE CONNECTED

2 Run THINKWARE CONNECTED and tap Sign In on your smartphone.

You need a THINKWARE ID to use THINKWARE CONNECTED. If you don’t have an ID, tap Sign Up and  

sign up for a THINKWARE membership.

3 After you sign in, follow the app's instructions. Tap Register a Device, and enter a barcode number to  

register a product. 
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https://www.thinkware.com/Support/Download
https://www.thinkware.com/Support/Download
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6. Settings

You can set the product features according to your needs and preferences using the mobile viewer or the 

PC viewer. The following procedures are based on the mobile viewer.

The product will stop recording while configuring settings on the mobile viewer.

6.1 Managing the memory card

From the mobile viewer, tap Dash Cam settings > Memory Card Settings to manage the memory card settings.

Options Description

Memory Partition
Select from Continuous Priority/Incident Priority/Parking Priority/Manual Priority/

Driving Recording Only for the memory partition type.

Formatting Memory Card
In Formatting Memory Card, tap Format > Confirm to proceed with formatting the 

memory card.

Overwrite Videos Select the desired modes to allow video overwriting.

6.2 Setting the Camera

From the mobile viewer, tap Dash Cam settings > Camera Settings to adjust the camera settings.

Options Description

Resolution
Select from 4K 30 fps + QHD 30 fps/QHD 60 fps + QHD 30 fps for the desired front/

rear resolution. 

Image quality

Select from Normal Quality/High Quality for the image quality of the front/rear 

camera. It is only enabled when 4K is selected in Resolution. If you select High 

Quality, the file capacity increases and the number of files that can be stored is 

reduced compared to when using Normal Quality.

Brightness-front Select from Dark/Mid/Bright for the brightness of the front camera.

Brightness-rear Select from Dark/Mid/Bright for the brightness of the rear camera. 

Rotate Rear Camera Select from Enabled/Disabled to flip the rear view image upside down. 

(Continuous Mode)

Super Night Vision 4.0
Select from Enabled/Disabled for the Super Night Vision feature.

(Parking Mode)

Super Night Vision 4.0
Select from Enabled/Disabled for the Super Night Vision feature.
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6.3 Setting recording features

From the mobile viewer, tap Dash Cam settings>Record Settings to manage the recording features settings. 

Options Description

Voice Recording Select from Enabled/Disabled.

Set Privacy Recording

You can set the privacy recording feature to delete your recorded files after a set 

amount of time to protect the privacy of others. Select from G-Shock only/1min 

(max. 2min)/3min (max. 4min)/Disabled for the privacy recording setting. If it is set 

to G-Shock only mode, then it is not consistently recorded.

Continuous Mode Incident 

Recording Sensitivity
Select from Lowest/Low/Mid/High/Disabled for the sensitivity.

Parking Mode
Select from Motion Detection /Time Lapse/Energy Saving /RADAR/Disabled  for the 

parking mode.

Parking Mode Waiting Time
Select from 30 sec./1 min./2 min./3 min./4 min./5 min. for the parking mode waiting 

time (time to switch to parking mode).

Smart Parking Rec Select from Enabled/Disabled for thermal protection and external battery saving .

Impact Sensitivity in Parking 

Mode
Select one of the five parking mode sensitivity levels.

Motion Detection Sensitivity Select one of the five motion detection sensitivity levels.

Radar Sensitivity Select one of the five radar sensitivity levels for the front/rear camera.

Use External Battery Select from Enabled/Disabled.

Off Timer Select the desired off time. To turn off the off timer, select Disabled.

Battery Protection Select from Enabled/Disabled for the battery protection.

Vehicle Type Select from Regular car/Hybrid car/Electric car  for the vehicle type.

Battery Cutoff Voltage Set the Battery Cutoff Voltage according to the vehicle type.

Wintertime Battery Protection Select the month(s) to apply the battery protection feature.

�  To use parking mode, you must install the hardwiring cable or OBD-II cable.
If continuous power is not supplied to the product, the product will stop recording when the vehicle engine 
is turned off.

The vehicle battery will not be charged while the vehicle is parked. If you record in parking mode for an
extended period, the vehicle’s battery may be depleted and you may not be able to start the vehicle.   

�

�  For more information about parking mode, refer to "3.6 Using parking mode" on page 20. 

�  The battery cutoff voltage can be set only when the Battery Protection setting is set to Enabled.

�  If the off voltage value is too low, the product may consume the battery completely depending on the 
conditions like the vehicle type or temperature.
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6.4 Setting road safety features

From the mobile viewer, tap Dash Cam settings > Road Safety Settings to manage the road safety features 

settings.

Options Description

Safety Cameras Select from Enabled/Disabled for the safety cameras.

Mobile Zone Alert Select from Enabled/Disabled for the mobile zone alert.

Vehicle Type Select the vehicle type from Sedan/SUV/Truck (Bus).

Initialize ADAS In Initialize ADAS, tap Initialize > OK to proceed with initializing.

LDWS  
(Lane Departure Warning)

Select from Disabled/Low/Mid/High for the LDWS sensitivity.

LDWS Speed Select from 50km/h / 60km/h / 80km/h / 100km/h for the LDWS detection speed.

FCWS  
(Forward Collision Warning)

Select from Disabled/Low/Mid/High for the sensitivity.

Low Speed FCWS Select from Disabled/Low/Mid/High for the sensitivity.

RCW
(Rear Collision Warning)

Select from Enabled/Disabled for the RCW feature.

RCWS Speed Select from 50km/h / 60km/h / 80km/h / 100km/h for the RCWS detection speed.

Rear Collision Recording Select from Enabled/Disabled for the rear collision recording feature.

FVDW (Front Vehicle Departure 
Warning)

Select from Enabled/Disabled for the FVDW feature.

6.5 Configuring the system settings

From the mobile viewer, tap Dash Cam Settings > System Settings to configure the hardware system settings.

Options Description

Language Select the desired language.

Volume
Select the desired volume level for each feature (Safety Cameras/ADAS/System 
and Others).

Security LED Select from Lateral/Blink/Spread/Disabled for the security LED.

Rear Camera LED Select from Enabled/Disabled for rear camera LED. 

Time Zone Select the date and time. 

Daylight Saving Select from Enabled/Disabled for the daylight saving.

Speed Unit Select from km/h/mph for the speed unit.

Speed Stamp Select from Enabled/Disabled for the speed stamp.

Wi-Fi Frequency Band Select from 2.4GHz/5GHz for the Wi-Fi frequency.   

Internet Select from Enabled/Disabled for Internet mode. 

If you select 0 for the volume level, the voice guidance will be disabled.
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7. Accessing the product information

New users may benefit from the basic product information that can be accessed from the Menu screen.

7.1 Viewing the product information

From the mobile viewer, tap Dash Cam Info to view product information. The following product information 

will be displayed on the screen.
• Model Name

• Memory Size

• Firmware Ver.

• LOCAL ID

• Safety Camera Ver.

• GPS Info

• Micom ver.

7.2 Accessing and configuring the GPS

A GPS module is used to include the location data in the recorded videos. From the mobile viewer, tap Dash 

Cam Info > GPS Info to view the GPS features. The connection status, signal strength, time (UTC), vehicle 

speed, current altitude, and Horizontal Dilution of Precision (HDOP) are displayed on the screen.

Tap  to initialize the GPS, and allow it to locate the current position.

Horizontal Dilution of Precision (HDOP)

HDOP is a value that refers to GPS deviation due to satellite positioning. 
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8. Upgrading the firmware

A firmware upgrade is provided to enhance the product’s features, operation or to increase stability. For 

optimal operation of the product, ensure that you keep the firmware up to date.

Follow the instructions to upgrade the firmware.

1 On your PC, open a web browser and go to https://www.thinkware.com/Support/Download.

2 Select the product and download the latest firmware upgrade file.

3 Unzip the downloaded file.

4 Disconnect power to the product and remove the memory card.

5 Open the memory card on a PC and copy the firmware upgrade file to the root folder of the memory 

card.

6 While the power is disconnected from the product, insert the memory card into the memory card slot 

on the product.

7 Connect the power cable to the product, and then turn on the power (ACC ON) or start the engine to 

turn on the product. The firmware upgrade starts automatically, and the system will restart once the 

firmware update is completed.

Do not disconnect the power or remove the memory card from the product during the upgrade. Doing 

so may cause serious damage to the product, or to the data stored in the memory card.

You can also update the firmware from the mobile viewer and the PC viewer.



9. Troubleshooting

The following table lists the problems users may encounter while using the product and measures to 

resolve them. If the problem persists after taking the measures provided in the table, contact the customer 

service center.

Problems Solution

Cannot power on the product 

� Make sure the power cable (the optional the hardwiring cable / OBD-II cable or 

car charger) is connected to the vehicle and the product properly.

� Check the vehicle’s battery level.

The voice guide and/or buzzer 

do not sound. 
Check if the volume is set to the minimum. 

The video is unclear or hardly 

visible.

� Ensure that the protective film on the camera lens has been removed. The

video may look unclear if the protective film is still on the camera lens.

� Check the installation location of the front or rear camera, turn on the product,

and then adjust the camera’s viewing angle.

The memory card cannot be 

recognized.

� Ensure that the memory card has been inserted in the correct direction. Before

inserting the memory card, ensure that the metal contacts on the memory card

are facing toward the lens of the product.

� Turn off the power, remove the memory card, and then check to ensure that the

contacts in the memory card slot are not damaged.

� Ensure that the memory card is an authentic product distributed by

THINKWARE. THINKWARE does not guarantee compatibility and normal

operation of third-party memory cards.

The recorded video cannot be 

played on a PC. 

The recorded videos are stored as MP4 video files. Ensure that the video player 

installed on your PC supports the playback of MP4 video files.

GPS signal cannot be received.

The GPS signal may not be received in out-of-service areas, or if the product is 

located between tall buildings. Also, GPS signal reception may not be available 

during storms or heavy rain. Try again on a clear day at a location that is known 

to have a good GPS reception. It may take up to 5 minutes until GPS reception is 

established. 

Before contacting a service center

Please back up all important data stored in the memory card. The data in the memory card may be deleted 

during repair. Every product requested for repair is regarded as a device that has had its data backed up. 

The customer service center does not back up your data. THINKWARE is not responsible for any loss, such 

as data loss.
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10 S . pecifications

To see the product specifications, refer to the following table.

Item Specification Remarks

Model name U3000 Rear Camera: BCQH-500 (optional)

Dimensions 69.8 x 98.1 x 55.5 mm Rear Camera: 79.3 x 36.9 x 31.9 mm (optional) 

Memory MicroSD memory card 64 GB, 128 GB, 256 GB

Camera sensor 8.4 Megapixel, 1/1.8'

Angle of view (Lens) Approximately 152° (diagonally)

Video

Front: 4K UHD (3840 x 2160 @30fps) 

or 2K QHD (2560 x 2160 @60fps) / 

H.265 / MP4

Rear: QHD (2560 x 1440 @ 30fps) / 

H.265 / MP4(optional)

Recording mode
Continuous Rec, Incident Rec, Manual Rec, Parking Mode 

(Motion Detection / Time Lapse / Energy Saving / Radar)

Features
Super Night Vision, Privacy Recording, Smart Parking Recording, 

Built-in Radar, External Battery connected with the dash cam

Acceleration sensor 3-axis acceleration sensor (3D, ±3G) 5 levels for sensitivity adjustment available 

GPS Embedded GPS
Supports ADAS features (LDWS, LDWS Speed, 

FCWS, Low Speed FCWS, FVDW, RCWS)

GNSS GPS/GLONASS 

Bluetooth
Standard Bluetooth V5.0, BLE

Frequency 2.402 MHz – 2.480 MHz

Wi-Fi

Standard 2.4G (802.11 b/g/n) / 5G (802.11 a/n)

Frequency
2.400 GHz – 2.483.5 GHz

5.15 GHz – 5.25 GHz

Radar module Frequency
24.00 GHz – 24.25 GHz

Front / Rear Camera (BCQH-500)

Power input DC 12 / 24 V supported Rear Camera (BCQH-500): DC 3.3 V

Power consumption 2ch: 5.88 W / 1ch: 3.64 W (mean)

Except for the fully charged supercapacitor / GPS

Actual power consumption may vary depending 

on the usage conditions and environment.

Rear Camera (BCQH-500): 0.55 W (mean)

Auxiliary power unit Super capacitor

LED indicator
Security LED, REC LED, GPS LED, 

Connection LED

Alarm Built-in speakers Voice guide (buzzer sounds) 

Operating temperature 14 – 140℉ / -10 – 60℃

Storage temperature -4 – 158℉  / -20 – 70℃
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FCC Statement
This	device	complies	with	Part	15	of	the	FCC	Rules.	Operation	is	subject	to	the	following	two	conditions:	(1)	
this device may not cause harmful interference, and (2) this device must accept any interference received, 

including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant 

to	Part	15	of	the	FCC	Rules.	These	limits	are	designed	to	provide	reasonable	protection	against	harmful	
interference in a residential installation. This equipment generates, uses and can radiate radio frequency 

energy and, if not installed and used in accordance with the instructions, may cause harmful interference 

to radio communications. However, there is no guarantee that interference will not occur in a particular 

installation. If this equipment does cause harmful interference to radio or television reception, which can 

be determined by turning the equipment off and on, the user is encouraged to try to correct the interference 

by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

• This appliance and its antenna must not be co-located or operation in conjunction with any other antenna

or transmitter.

• A minimum separation distance of 20cm must be maintained between the antenna and the person for this

appliance to satisfy the RF exposure requirements.

FCC CAUTION: Any changes or modifications to the equipment not expressly approved by the party 

responsible for compliance could void your authority to operate the equipment.

FCC ID: 2ADTG-U3000
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Information to user : RSS-247
This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment. This 

equipment should be installed and operated with minimum distance 20 cm between the radiator & your 

body. 

This device contains licence-exempt transmitter(s)/receiver(s) that comply with Innovation, Science and 

Economic Development Canada’s licence-exempt RSS(s). 

Please be cautioned the changes or modifications not expressly approved by the party responsible for 

compliance could void the user’s authority to operate the equipment.

Notice: Operation is subject to the following two conditions : (1) this device may not cause interference, and 

(2) this device must accept any interference, including interference that may cause undesired operation of

the device.

This Class B digital apparatus complies with Canadian ICES-003.

IC:	12594A-U3000
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